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Skill Set 3
Formulas

By the end of this Skill Set you should be able to:

Create Simple Formulas
Understand Totals and Subtotals
Use Brackets
Select Cells with the Mouse to Create Formulas
Calculate Percentages
Understand Ranges
Use AutoSum for Totals and Subtotals
Copy and Paste Formulas
Use the Fill Handle
Check and Correct Errors in Formulas
Correct Circular Reference Errors
Use Help
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Exercise 17 - Introducing Formulas
Knowledge:
A calculation in Excel is called a Formula. Formulas are used to calculate results
from numbers entered on the sheet, e.g. add a column of numbers, total sales for
the year, calculate net profit in a month, etc. Formulas automatically calculate
results from the data. The original data can be changed, but the formula will
automatically recalculate. This allows results to be projected from different data, but
using the same formula.
All formulas begin with an equals sign (=), followed by the calculation.
The basic mathematical operators are add (+), subtract (-), multiply (*) and divide
(/). These symbols appear twice on the keyboard, one set placed around the main
keyboard and the other set on the numeric keypad (right side). Many people find
that the numeric keypad is easier to use because the keys are closer together and
the <Shift> key is not needed.
To make results valid and fit for purpose make sure that the correct formulas are
used. Excel will only do what you tell it to do, e.g. adding two numbers when you
meant them to be subtracted is a valid formula but produces an inaccurate result.

Activity:
1.

Open the workbook Operators.

2.

To add the contents of B4 and B5, make B6 the active cell by clicking on it,
and type in = then click on cell B4, type + then click on cell B5. Press
<Enter>. This creates a formula to add the contents of cells B4 and B5.

Note: Clicking on cells to enter them in formulas is easier and results in less
mistakes than typing.
3.

Click in cell C6 and create the formula to subtract the two numbers above,
=C4-C5 using a combination of typing and clicking. Complete the entry by
pressing <Enter>. The answer is displayed as 5.

4.

In cell D6, enter the formula to multiply the two numbers above, =D4*D5.
Complete the entry. The answer is 28.

5.

In cell E6, enter the formula to divide the two numbers above, =E4/E5.
Complete the entry. The answer is 5.

6.

Save the workbook as operators2 and close it.
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Exercise 18 - Brackets
Knowledge:
When more than one operator is used in a single formula, then the order becomes
important, e.g. D23+E17/E19. Excel performs calculations in this order: Brackets
Order Division, Multiplication, Addition and finally Subtraction (the BODMAS
theory). So in this example E17 would be divided by E19 then added to D23.
Brackets are added to force Excel to perform calculations in a different order.

Activity:
1.

Start a new workbook.

2.

Click on cell C2 and input the following data.

3.

To calculate the profit, the buying price must be subtracted from the selling
price and then multiplied by the number sold. Click on cell C6 and enter the
formula =C3-C4*C5.

4.

Press <Enter> to complete the formula. The answer given is -8 (this is
because the multiplication is carried out before the subtraction: the BODMAS
theory).

5.

Click on cell C6 and press the <Delete> key. This time add brackets around
the subtraction. Type =(C3-C4)*C5 press <Enter>.

Note: Brackets are added to force Excel to perform calculations in a different order
to normal, i.e. inside the inner brackets first.
6.

Check that the answer displayed is 12. Profit per item is 10-6, which is 4
multiplied by the number sold, 3, giving the total profit of 12.

7.

Enter the following data, beside the first block starting at cell E2.
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Exercise 18 - Continued
8.

In cell F6, the total income will be calculated by multiplying the Price by
Number e.g. 20 by 2 and 30 by 5 and then adding these together, then
dividing by 100 to give the price in pounds. Enter the formula
=E3*F3+E4*F4/100.

9.

The answer is £41.50, which is not correct. Brackets must be used to make
sure Excel performs the calculations in the right order, e.g. the multiplications
first, the addition second and the division last.

10.

Click on cell F6 and press the <Delete> key.

11.

Now enter the correct formula, =(E3*F3+E4*F4)/100 (Brackets are always
used in matching pairs). The formula works as multiplication is done before
addition, if in doubt, add a set of brackets around each of the multiplications,
e.g. =((E3*F3)+(E4*F4))/100.

Note: When brackets appear inside other brackets, the inside brackets are always
calculated first.
12.

Save the workbook as profit and close it.
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Exercise 19 - Percentages
Knowledge:
Percentages are displayed with a percentage symbol, e.g. 25%. A percentage is a
fraction or decimal displayed differently. Percent means per hundred. 20% is
20/100 as a fraction or 0.2 as a decimal.
There is a Percent Style button,

, that changes a decimal to a percentage.

Activity:
1.

Start a new workbook and create the following worksheet.

2.

To display the first number as a percentage of the second in D3, enter the
formula =B3/C3 using any method. Press <Enter>.

3.

To format the answer as a percentage, click in the answer cell and then click
the Percent Style button,
number percentage).

, on the Number group (this displays whole

4.

Change the second number to 27 and press <Enter>, notice that the
percentage value changes automatically.

5.

To display percentage with two decimal places, make the active cell D3. In
the Number group, click the Increase Decimal button,
the percentage with 2 places of decimal.

, twice to display

Note: Places of decimal can also be set using the Format Cells dialog box. Click
the launcher on the Number group to display the Format Cells dialog box.
Make sure the Number tab and Percentage within Category are selected
and change the value in the Decimal places box. Click OK to complete the
process.
6.

Excel 2010
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Exercise 20 - AutoSum
Knowledge:
The most common formula is addition. This calculation has been simplified by the
creation of a Function called Sum. Functions (covered in full in a later Skill Set)
are pre-calculated formulas. There is a button called Sum,
, that sums cells
automatically. This button is so widely used in Excel that it can be found on two
different Ribbon tabs; on the Home tab in the Editing group and on the Formulas
tab in the Functions Library group.

Activity:
1.

Open the workbook Autosum.

2.

In cells A9 and H3, enter the label Total.

3.

Click on cell B9. The five cells above need to be added together to find the
total. Add them using the mouse to select each of the cells. The formula is
=B4+B5+B6+B7+B8. The answer should be 59.

4.

Why add cells that contain nothing? You may ask. Well, if numbers were
placed in these cells at a later stage then the formula would still work
whereas the formula with cells missing from the range would not.

5.

As more and more numbers are added this method becomes unworkable.
There is a function: SUM that adds a group of cells. Click on cell C9.

6.

Click the Sum button,

7.

The program looks for numbers to add. AutoSum finds only one number
above. Click on cell C4 and with the mouse button still pressed drag to cell
C8, and release the mouse button, the range C4:C8 is selected.
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Exercise 20 - Continued

8.

Press <Enter> to place the answer 73 in cell C9.

9.

Click in cell H4 and click the Sum button,
. AutoSum tries to add
numbers above first, there are no numbers above, it looks left and sums the 2
cells F4 and G4, click and drag the range B4 to G4. Press <Enter>. The
answer is 84.

Note: AutoSum will only use an automatic range when numbers have already
been entered into the worksheet. If there are numbers in both directions it
will sum upwards by default.
10.

Excel 2010

The other formulas will be created later by copying. Save the workbook as
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39

© CiA Training Ltd 2012

Spreadsheet Software

Level 2 ITQ

Exercise 21 - Totals and Subtotals
Knowledge:
A Total is the sum of a range of numbers. A Subtotal is still the sum of a range of
numbers except that it is part of a bigger range. For example a range split into
different items, products, departments, factories etc.; each subsection is totalled
and then a grand total is achieved by adding the subtotals.

Activity:
1.

Open the workbook World. This is a workbook showing the populations of
countries, grouped by continent. These figures are only a representation of
the actual populations.

2.

The populations need to be summed. In cells B22, B37, B50 and B57 enter
the text label Subtotal. You will need to scroll down column B to see the
hidden data.

3.

Make the subtotal labels and the cell to the right of each bold by selecting
them and clicking the Bold button,

, in the Font group on the Home tab.

4.

Click on cell C22 and click the AutoSum button,
in the Editing group
on the Home tab. Press <Enter> to complete the subtotal.

5.

Click on cell C37 and use the AutoSum button again. It sums the numbers
up to the previous total. Press <Enter> to complete the formula.

6.

Complete the other two subtotals in cells B50 and B57.

7.

Enter the text Grand Total in cell B58.

8.

To add the subtotals in cell C58, click in the cell and click the AutoSum
button. Excel adds the four subtotals from above automatically.

9.

Press <Enter> to complete the Grand Total formula and make the range
B58:C58 bold by clicking the Bold button,

10.

.

Save the workbook as subtotals and then close it.
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Exercise 22 - Copy and Paste
Knowledge:
Rather than repeatedly typing the same data into several cells, the data can be
copied and then pasted.
The Copy command can be used to copy labels, values and formulas. The
selected cells are placed in an area of Windows called the Clipboard, from where
they can then be Pasted back into the same worksheet, a different worksheet in
the same workbook or even a different workbook.

Activity:
1.

Start a new workbook.

2.

Make the cell B3 active and type HELLO and press <Enter>.

3.

To copy this cell, click on cell B3 and then click the Copy button,
Clipboard group, on the Home tab.

, in the

Note: An alternative method is to use the key press <Ctrl C>.
4.

The selected cell will now have a broken border (called a Marquee) and the
message Select destination and press ENTER or choose Paste is
displayed in the Status Bar.

5.

Click on cell B7 and press <Enter>. The contents of B3 will now be pasted
into B7. The contents of B3 remain unchanged. Note that B3 no longer has a
broken border.

6.

Enter 65 into cell C6 and press <Enter>, select the cell and click the Copy
button,

7.

.

Move to B9 and click the Paste button,
in the Clipboard group. Note
that C6 still has a broken border, indicating that its contents can be pasted
again if required.

Note: An alternative method is to use the key press <Ctrl V>.
8.

Move to B10 and paste again.

9.

Press <Esc> to end the pasting and remove the marquee from around cell
C6.

10.

Close the workbook without saving the changes.
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Exercise 23 - Using the Fill Handle
Knowledge:
Ranges can be quickly filled with data by using the Fill Handle, which appears
when the cursor is placed over the bottom right corner of the active cell.
Fill Handle
(Black +)

It is only possible to drag in one direction, i.e. along a row or down a column. An
extra feature of dragging the Fill Handle is the ability to automatically fill ranges
with titles such as months of the year, days of the week, any text ending with a
number or a date.

Activity:
1.

Open the workbook Autosum2. Click in cell C9 to see the formula.

2.

To save re-typing the formulas in row 9 and column H, the formulas can be
copied using the Fill Handle. With the active cell as C9, click and drag the
Fill Handle across to G9. Release the mouse button.

Note: D9 will sum column D and E9 will sum column E etc.
3.

Click in cell D9 and check the Formula Bar to see that the formula has been
updated automatically to sum column D instead of column C.

4.

To complete column H make the active cell H4 and drag the fill handle down
to H9. The completed spreadsheet should look the same as below.

Note: The AutoFill Options button appears. This allows different formatting to be
added. Performing another unrelated action removes it.
5.

Save the workbook as autosum3 and close it.
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Exercise 24 - Finding Help in Excel
Knowledge:
Excel contains a very useful and comprehensive Help facility. If you forget how to
use a feature of the program or encounter an unexpected problem, this extra
source of information will be of great help.
Help topics are available from either Office Online (via the internet) or from the
content installed on your computer (offline). The method of using Help is the same
in either case but the content may vary slightly.

Activity:
1.

Click the Help button,
Excel Help screen.

, found to the far right of the Toolbar, to display the

Note: Pressing the <F1> key will display the same Help screen. The window can
be moved, resized or maximised if required. The contents of the help may
not appear exactly as shown below.
2.

If the Table of Contents panel is not displayed on the left, as shown below,
click the Show Table of Contents button,

, on the Excel Help toolbar.

Search
Box

Table of
Contents

Search
Scope

3.

The Search Scope button at the bottom of the window indicates whether you
are connected to Office Online or not (offline). Click on the button to see the
available options, and make sure Show content from Office Online is
selected.

4.

Help can be used in two ways. You can either browse through the listed
topics or type keywords into the Search box.
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Exercise 24 - Continued
Note: The content and appearance of the information provided by the online Help
system is constantly updated and may not appear exactly as described here.
5.

A list of categories is shown on the opening screen in the main display area.
Click on any one that is of interest to you to display a list of relevant topics.

6.

Scan the topics shown and again select any one that interests you. Read the
help information shown.

7.

To move back to a previous screen, click the Back button,
Help toolbar. You are then able to follow another link.

, on the Excel

Note: Help topics can be printed for reference by clicking the Print button,

.

8.

Click the Home button,
help screen.

9.

Another way to find help is to search by keyword. Type shortcuts into the

, on the toolbar to return directly to the starting

Search box and click the Search button,

(or press <Enter>).

10.

There may be many topics found for your search and it will be necessary for
you to use your own judgement and select the most appropriate one.

11.

The Table of Contents panel can be hidden again by clicking the Hide Table
of Contents button,

12.

, on the Help toolbar.

Close the Help window by clicking its Close button,
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Exercise 25 - Displaying Formulas
Knowledge:
When a cell contains a formula, the result of the formula rather than the formula
itself is displayed in the cell. This is because normally the value is the required
result. However, it is possible to display formulas on a worksheet rather than the
results of the formulas. This is very useful when checking for errors.

Activity:
1.

Open the workbook Retail.

2.

To show all the formulas on the screen, display the Formulas tab and then
click the Show Formulas button,
in the Formula Auditing
group. The columns are widened as the formulas take up more space than
the numbers.

Note: Sometimes the columns are not widened enough to show the whole of the
formulas. The columns would need to be widened as the formulas must be
displayed in full for this qualification. The widening of columns is covered
later.

3.

, changes colour to show that it
The Show Formulas button,
is active. Click the Show Formulas button again to turn off the formula
display.

4.

There is also a quick key press for switching between the formulas and their
results, <Ctrl `>, i.e. Ctrl and the key to the left of 1. Switch to the formula
display using the quick key press, <Ctrl `>.

5.

Press <Ctrl `> to remove the displayed formulas.

6.

Close the workbook without saving.
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Exercise 26 - Checking Formulas
Knowledge:
Spreadsheets are of little use if the formulas within them contain errors. All
formulas within worksheets should be checked to make sure that they are accurate
and therefore produce the correct results.
When some formulas are created they produce errors. When a formula cannot be
calculated the cell displays an error message.
All error values begin with a #. The following are the error types:
#NULL!

The two areas specified do not intersect

#DIV/0!

Division by zero

#VALUE!

The wrong argument used

#REF!

Cell referenced is not valid

#NAME?

Does not recognise text in a formula

#NUM!

Error with number in formula

#N/A

The value used in the formula is not available

######

The result is too long to fit into the cell. A Tooltip shows the
actual contents of a cell. This is a display problem rather than
a data error.

Activity:
1.

Open the workbook Formulas.

2.

To check a worksheet for construction errors the Error Checking command
is used. Select the Formulas tab from the Ribbon and click
. in the Formula Auditing group. The first error is displayed.
The cell A5 is used in the calculation and A5 contains text.
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Exercise 26 - Continued
3.

The buttons on the right are used to help correct the error, click Edit in
Formula Bar. Remove A5+ from the formula and click Resume.

4.

Further errors are displayed by clicking Next. In this case the error checking
is complete because the error in B5 was causing all the other errors.

5.

Click OK.

6.

To check that a formula references the correct cells, click on the cell
containing the formula and check the formula in the Formula Bar. Click on
cell C5 it should be =B5+C4.

7.

A much better way to check formula references is to double click on the
required cell. Double click on cell E5. The formula is displayed in the cell with
colour coding to show which cells are used. After checking, press <Enter> or
<Esc> to finish the editing.

8.

Check all the formulas in row 5. The first B5 is simply a copy of the first
month, =B4. The other formulas should add the previous cell to the one
above as in the diagram. The last cell H5 is copy of the previous cell, =G5.

9.

Double click on cell H4. The range is shown in blue and is correct. The range
if incorrect can be adjusted by clicking and dragging any corner (handle).
Click and drag one of the handles on the right to reduce the range by one
cell. Release the mouse button to see the effect. The range is amended to
B4:F4 in the formula.

10.

Press <Enter> to complete the formula.

11.

Double click on cell H4 and adjust the range to include G4 as before.

12.

In cell B8, enter the number 5 and in C8, enter the number 2.
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Exercise 26 - Continued
13.

In cell D8, enter the formula to divide the two numbers, i.e. =B8/C8.

14.

Change the number in cell C8 to 0 (zero).

15.

This produces a #DIV/0! Error, with a Smart Tag next to it. Click on cell D8
and place the mouse on the Smart Tag to display the error.

16.

Click on the drop down arrow of the Smart Tag to display a menu of options.

17.

Select Ignore Error.

18.

Close the workbook without saving.
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Exercise 27 - Circular References
Knowledge:
A Circular Reference occurs when a formula includes the cell itself. At this level a
circular reference will have been created in error and the problem will need
correcting.

Activity:
1.

Start a new workbook and enter two small numbers in cells, C3 and C4.

2.

Click in cell C5 and enter the formula =C3+C4+C5. Press <Enter>. Excel
displays a Circular Reference Warning.

3.

Click Help. Excel Help is displayed.

4.

Read the help and then close Excel Help.

5.

Click OK and then amend the formula in C5 by deleting +C5 from the end.
Complete the formula. The Circular Reference is removed.

6.

Close the workbook without saving.
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Exercise 28 - Develop Your Skills
You will find a Develop Your Skills exercise at the end of each Skill Set. Work through
it to ensure you’ve understood the previous exercises.
1.

Start a new workbook.

2.

The illustration below shows the number of high-tech components produced
in a week by the different factories of a precision engineering company.
Create the following worksheet. Note that not all the factories produce all the
products.

3.

In cell F4, use AutoSum to work out the total number of Wottnotts produced
across the four plants.

4.

In cell B8, calculate the total output of the Factory1 for the week.

5.

Use the Fill Handle to replicate the formula in F4 down to F7.

6.

Copy the formula in B8 across to F8.

7.

Check all the formulas in the worksheet by displaying them.

8.

What was the total production of the Factory2 in that week?

9.

How many Doodahs did the four factories produce between them during the
week?

10.

What was the total output for all four products across all the four factories?

11.

Save the workbook as engineering and close it.

Note: The answers are listed in the Answers section at the end of the guide.
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Summary: Formulas
In this Skill Set you have been introduced to formulas, created formulas including
mathematical operators and brackets. Percentages have been explained and used.
You have also used formulas to create totals and subtotals, copied formulas and
corrected errors found in formulas, including circular references.
The in-built Help system has been used to aid you in finding information and problem
solving.
You should be able to demonstrate your ability to:
•

Create and copy simple formulas

•

Analyse and manipulate data by using:

•

•

•

Excel 2010



Mathematical operators, add, subtract, multiply and divide



SUM to create totals and subtotals



Brackets



Percentages

Check and respond to errors in spreadsheets:


Use Help



Display and check formulas

Correct errors in


Formulas



Circular references

Check the accuracy of results
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